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CSE meeting with IPEd, 29 May 2017
IPEd has now been up and running for almost a year, and they invited CSE to 
meet for a chat. 

Those present for IPEd were Karen Lee (IPEd CEO), Kerry Davies (IPEd Chair) 
and Julie Ganner (NSW Branch President—those CSE members who joined 
IPEd will mostly have been assigned to the NSW Branch). CSE was represented 
by Johann Idriss (President), Eris Harrison (Vice-President), Alan Cummine 
(Immediate Past President), Elizabeth Manning Murphy and Ted Briggs.

The meeting was informal, over lunch, and respectful on both sides. IPEd 
representatives updated us on progress and on ways IPEd is working to 
resolve some of the challenges that inevitably arise with a start-up. The 
Company Secretary and Administration roles have been more clearly defined, 
new financial systems are in place, and staffing appears to be stable at 
this point. They are optimistic about the future, in the light of some serious 
strategic planning, priority setting and system development undertaken 
recently. From the massive list of goals in the White Papers, IPEd is continuing 
to refine and to focus on the immediate possibilities. Karen has met with 
several key organisations, including the Australian Publishers Association, the 
Australian Society of Authors, the Media Entertainment & Arts Alliance, and 
the Copyright Agency to promote IPEd and editors’ interests. The Associations 
Forum is working with IPEd and will assist with reviewing the Constitution 
which is likely to lead to changes. The first IPEd AGM is to be held in Brisbane 
on the afternoon of Thursday 14 September 2017, during the 8th IPEd National 
Editors Conference.

IPEd would, of course, like CSE to become part of IPEd in the fullness of time. 
CSE’s concerns were discussed, and we were assured that they will all be 
taken into consideration in the upcoming constitutional review. We emphasised 
that some of our concerns remain serious sticking points for our members and 
that some of these would require constitutional change. IPEd undertook to 
respond afresh to our list of outstanding issues.

CSE believes that our Society is operating very efficiently and effectively for 
members. We would, however, welcome a speaker from IPEd down the track, 
as changes are made, to inform our members of the situation and the options. 
Julie Ganner also agreed to visit when the time is right, to explain to CSE 
members some of the practicalities of being in an IPEd Branch.

The meeting was convivial and collegiate, and it was also informative and 
useful. CSE and IPEd will continue to cooperate on national issues such as 
academic-editing standards. While nothing will change structurally in the near 
future, those present agreed that progress is being made, and that the issue 
of CSE’s possible future inclusion in IPEd was one for ongoing discussion, 
particularly following the planned constitutional review. 

CSE President and Committee

http://iped-conf2017.org.au/
http://iped-conf2017.org.au/
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IPEd National 
Editors Conference 

Program for the 8th IPEd National 
Editors Conference is OUT NOW

The much-anticipated program for the 8th IPEd National Editors 
Conference has been launched. In line with the theme of the conference, 
Advancing Our Profession, the program features three streams 
of presentations and panels across two days, preceded by a day of 
workshops. 

In the Building Alliances stream, sessions include a look at the 
challenges of editing theses, an emerging leaders forum, the importance 
of building relationships, an indexers panel and a building alliances panel 
with guests from other industry organisations.  

Under the Professional Development banner, there will be panels 
about mentoring and freelancing, as well as sessions on being an editee, 
working with contracts and postgraduate theses and a session by the 
recicpient of the Beatrice Davis Editorial Fellowship.

The final stream is Technology, which includes a look at baby boomers 
and millennials, the benefits of screencasting for editors and sessions 
on editing scientific and educational digital publications. It also includes a 
panel on accreditation for editors. 

A highlight of this year’s event is the inaugural Rosanne Fitzgibbon 
Editorial Award at the conference dinner. Known as the Rosie, the award 
commemorates the contribution to Australian publishing by the late 
Rosanne Fitzgibbon. 

The conference’s three keynote speakers are The Courier-Mail cartoonist 
Sean Leahy, linguist and regular ABC Radio guest Professor Roly Sussex 
and author and publisher Sophie Cunningham. More detail about their 
sessions will be announced in the coming months. 

This year’s IPEd conference is hosted by Editors Queensland. The 
conference will be held from 13 to 15 September 2017 at the Brisbane 
Convention and Exhibition Centre. Early-bird registration is available until 
13 July. 

To see the program 
and to register, 
visit here.

http://iped-conf2017.org.au/
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IPEd National 
Mentoring Program

Next steps for our program
Since we last met in these pages, there have been a couple of 
developments that we hope all readers will be interested in:

First, the ‘management team’ of the program has now been convened 
as a standing committee of IPEd, with Ted Briggs AE and Elizabeth 
Manning Murphy DE as joint chairs and remaining joint national 
coordinators of the program. The state coordinators around Australia 
comprise the rest of the committee. The resolution below was passed at 
IPEd Council’s meeting in November 2016 and recently passed on to us in 
Canberra:

Resolution: That the IPEd Mentoring Standing Committee be 
convened with its members consisting of branch mentoring 
coordinators of the mentoring program and jointly chaired by 
Ted Briggs and Elizabeth Manning Murphy as national mentoring 
coordinators. 

Second, our bid to host a panel discussion about mentoring at 
the IPEd Conference in Brisbane this year was accepted. Ted and 
Elizabeth will host the discussion on Friday afternoon, 15 September, 
with panellists consisting of two mentors of editors (Carolyn Leslie and 
Lorna Hendry, both from Victoria) and their respective mentees, Simone 
Beever and Kate Hawkins, plus Marisa Wikramanayaka (WA) joining 
the panel to discuss mentoring for writers. We hope that some of the 
state coordinators on the standing committee will be able to attend the 
conference and join in part of the discussion. In any event, coordinators 
plan to have lunch together on that Friday and as our presentation is 

Editing workshops available during the conference
During the conference, there’s a workshop to suit any of your editing 
interests. 

Workshops will be held on Wednesday 13 September at the Brisbane 
Exhibition and Convention Centre at Southbank. Early-bird workshop rates 
apply until 13 July. 

The workshop schedule includes Dr Lisa Lines’s class on how to use 
IPEd’s Guidelines for editing research theses in a changing tertiary 
environment, including identifying the line between copyediting and 
rewriting a thesis for a student writing in English as a second (or third) 
language.  

Belinda Pollard will impart her tips on how to make a tangible imprint in 
the virtual world. The workshop will help you navigate social media, work 
out how to attract your ideal customer, and tweak your online presence.   

Hilary Cadman will present a workshop on EndNote for editors to help 
academic editors, and those interesting in getting into the field, learn 
about the fundamentals of the referencing software.  Researcher 
commonly use EndNote to capture their publication outputs and source 
material. 

Jackey Coyle’s workshop will offer her key steps to managing yourself as 
an employee, including promotion, finance, and juggling your priorities. 

Ann Bolch will show workshop participants how a fresh set of eyes 
can take a new view of a manuscript, identify the missing pieces and 
help your author add more flesh to their story through manuscript 
development. This workshop is particularly useful for editors of fiction. 

Register for the IPEd national conference and workshops here and follow 
@lPEd_Conf on Twitter for updates. 

Christine Atkinson
IPEd conference communications, Editors Qld

Membership
A warm welcome to the following 
new members!

Full members
Kate Le Strange 
Leanne Manthorpe
Terry Johnston

Corporate members
Early Childhood Australia 
(Christopher Jones)

Associate members
Isabella Edquist
Malcolm Scott 
Penelope Royston

Student member
Todd Herzman

Members joining after July 1 2016 
have calendar year membership 
from the date they have paid their 
initial fees. Existing members as at 
July 1 2016 have a renewal date of 1 
July; this means it’s time to renew 
you membership.

Email reminders have been sent to 
all financial members. Thank you to 
all who have renewed so promptly.

Linda Weber AE

Membership Secretary and  
Public Officer

http://iped-conf2017.org.au/
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the last before afternoon tea, we hope conference delegates will take 
the opportunity to talk to us over a cuppa about mentoring and being 
mentored in our program.

More about our state coordinators
In this issue of The Canberra editor, we are featuring two more state 
coordinators: Geoff Dawson, our ACT coordinator in the Canberra Society 
of Editors—always one of the smaller groups in Australia; and Louise 
Zedda-Sampson who looks after the interests of the program in Victoria—
no mean feat as Victoria is the largest branch of IPEd. Here they are, in 
photos and words, for you to meet:

Geoff Dawson writes: ‘I’ve had a varied career 
as a language teacher, a historic buildings 
specialist, and for many years a researcher, writer 
and editor in parliamentary committees. In 2014 
I decided to go back to my first love, language. 
I now divide my time between freelance 
nonfiction editing and editing Hansard transcripts 
of the Australian Parliament. My special interests 
are making technical topics more accessible 

to general readers and teaching grammar in a way that is most useful 
to time-poor adults who want to improve their writing skills. If you’re 
interested in being either a mentor or a mentee in the ACT, I’d love to talk 
to you.’ To contact Geoff, email geoffdawsoneditor@gmail.com.

Louise Zedda-Sampson is a freelance 
writer and editor with a passion for clear 
communication and the written word. She has 
a Diploma of Professional Writing and Editing 
and writes fiction and nonfiction; her writing 
interests range from horror to history. Her editing 
interests have been an assortment of survivor 
stories, business documents, intergalactic 
wars, psychology papers, and fictional tales 

of the Aztec underworld. As the current IPEd Mentorship Coordinator 
for Editors Victoria and a former mentee, Louise sees the value in the 
Mentoring Program and enjoys the role of helping mentees and mentors 
to find suitable matches. Louise says, ‘The mentoring program allowed 
me to develop my confidence and my skills. I had an excellent mentor, 
and without this guidance I would not be where I am today. I’m forever 
grateful for the kindness and encouragement shown by my mentor that 
has assisted me to be a better editor, and I enjoy helping others to obtain 
the same result.’ To contact Louise, email mentorship@editorsvictoria.
org.

We hope to bring you two more state coordinators next issue. Meantime, 
here are the email addresses of the rest of the team—wherever you are 
reading this article, do contact the coordinator in your state for information 
about the Mentoring Program:

Roberta Blake (Qld) roberta.r.blake@gmail.com

Shannon Kelly (NSW) shannon.tyler.kelly@gmail.com

Catherine Schwerin (WA) caschwerin@gmail.com

Adele Walker AE (SA) adeleanderson@aapt.net.au

Sheelagh Wegman AE (Tas) wegmans@internode.on.net

Elizabeth Manning Murphy DE with Ted Briggs AE 
emmurphy.words@gmail.com tedbriggs@grapevine.com.au
Joint National Coordinators

Mentoring in the ACT

IPEd’s mentoring program for 
editors is going strong with some 
new contacts in the ACT following 
up a talk that Elizabeth Manning 
Murphy and I gave to the CSE’s 
general meeting on 22 February. 

If you missed the talk but you’re 
interested in being mentored or 
offering to be a mentor, you’ll be 
welcome. Any aspect of editing 
or related business topics is fair 
game (there are suggestions in 
the Guidance Notes on the IPEd 
website). 

Prospective mentors attend a 
Skype workshop facilitated by 
the national coordinators. The 
workshop is free, and anyone 
interested in being a mentor in 
the program can attend. Existing 
mentors who’d like a refresher 
are also welcome. The workshop 
discusses what it means to be a 
mentor and runs through some 
case studies. We expect that 
there will be a workshop before 
IPEd’s September conference.

If you’re interested in being 
mentored or offering to be a 
mentor, or if you’re an existing 
mentor and you’d like to attend 
a Skype workshop as a refresher 
(we’d encourage this), send me 
a quick email and I’ll be happy to 
get back to you to discuss further.

Geoff Dawson AE

ACT Mentoring Coordinator, and  
CSE Treasurer
geoffdawsoneditor@gmail.com
0410 251 063

mailto:geoffdawsoneditor@gmail.com
mailto:mentorship@editorsvictoria.org
mailto:mentorship@editorsvictoria.org
mailto:roberta.r.blake@gmail.com
mailto:shannon.tyler.kelly@gmail.com
mailto:caschwerin@gmail.com
mailto:adeleanderson@aapt.net.au
mailto:wegmans@internode.on.net
mailto:emmurphy.words%40gmail.com?subject=
mailto:tedbriggs%40grapevine.com.au?subject=
http://www.iped-editors.org/Professional_development/Mentoring.aspx
http://www.iped-editors.org/Professional_development/Mentoring.aspx
mailto:geoffdawsoneditor@gmail.com
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CSE March General 
Meeting

Styling Style Sheets
CSE member, Dr Lisa Lines AE, delivered a lively and practical explanation 
of Style Sheets—their form, function and use. Lisa spoke to an exceptionally 
large group of attendees at the CSE General Meeting on Wednesday 
29 April. Clearly, this was a topic of great interest to the mix of novice, 
intermediate and experienced editors who attended. 

Lisa emphasised the importance of creating a Style Sheet, as a guide to 
both editors and authors. An editor can consult it if they are working on 
a long document to ensure consistency, and an author may use it as a 
guideline if changes to the text need to be made following the edit.

All style decisions should be included. Examples of choices that might 
need be set out included: spaced en-dashes or non-spaced em-dashes; 
referencing styles, particularly for newish sources such as YouTube; use 
of shortened forms; any single word that seems to be a hazard in terms of 
spelling, hyphenation, capitalisation or italicisation;  and any common author 
errors. Lisa discussed the benefits and disadvantages of using the Microsoft 
Word Comment function rather than the Style Sheet, and she handed 
around a sample Style Sheet which included a number of different recording 
areas. Several of these were discussed. Lisa promised to distribute an 
exercise for members, and this was distributed later via a broadcast email to 
CSE members. 

Communication with the author will determine exactly how much 
information the author wants, but it is an editor’s role to do everything 
possible to ensure that achieving consistency is easy. The author needs to 
be made aware that, if the style recommendations are rejected, they may 
need to search for instances that the Style Sheet use already exists, in order 
to change those to the preferred option.

Questions abounded, and the discussion continued to the point where 
we had to rush to leave the Library by the 8 pm deadline. Lisa is to be 
congratulated on a presentation that clearly hit the mark.

Eris Jane Harrison AE
CSE Vice-President

April General 
Meeting

The ins and outs of EndNote
Dr Farid Rahimi—scientist, editor and overseer of The Canberra editor—was 
guest speaker at April’s monthly meeting. He provided a detailed overview 
of EndNote X8, which is a very handy software package for managing 
research citations and generating bibliographies. Farid’s talk was hands-on 
and heavily illustrated, so I’ve organised my notes as a series of tips rather 
than prose. Training videos are available on the EndNote YouTube channel, 
so users may want to consult the videos for more information. Anyway …

Getting started
To generate a new EndNote library, use menu items File > New. When you 
save your new library EndNote will generate two files with suffixes .enl and 
.data. It is important to keep these together.

To open an EndNote library use File > Open > Library.

Looking at an EndNote library
An EndNote library has four panes. The left column is the ‘groups’ panel, the 
top pane is the search window (search options include Boolean searches), 
the right pane shows details of the selected reference, and the rest of the 
screen displays the library contents.

Panes may be resized by grabbing and dragging their edges with your 
mouse.

You can click on column headings (e.g. ‘Author’) to organise/alphabetise the 
contents according to that column.

https://www.youtube.com/user/EndNoteTraining
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So much style!
EndNote has over 6,000 styles to use to alter the layout of your formatted 
bibliography to suit the style of a target journal.

EndNote’s default style uses hyphens rather than en-dashes for page 
ranges. You may want to find these and replace with en-dashes in your 
Word document. 

It is possible to modify styles, but always use ‘save as’ rather than 
overwriting the original style in case you need the original style again in 
future.

Sharing EndNote libraries
Don’t share EndNote libraries via the Cloud or Dropbox as eventually files 
become corrupted.

You can export references to a travelling library from a Word document 
(note that some information, such as the abstract, will be missing). You 
can do this if someone gives you a Word document with EndNote field 
codes but you don’t have their EndNote library. Once you’ve opened a 
travelling library you can alter styles.

Populating your library with references
EndNote has three ‘mode’ buttons on the top left of the screen (beneath 
the File and Edit menus); these can be used to access your own and 
external databases. The middle mode button allows you to search 
online. Use a Boolean search to find references that fit your criteria, then 
highlight relevant entries and save to your local library. This will import all 
details of each reference, including abstracts.

Alternatively, you can search particular databases (e.g. PubMed) for your 
search terms, then use ‘send to citation manager’ and import into your 
library.

If you download data for a citation and the full text is publicly available (or 
you have a subscription), it will download the PDF as well as the citation 
data. You can then open the PDF from within EndNote.

To import a PDF file use menu items File > Import > File, browse to 
desired PDF, then import.

Tidying up
To clean up library references use menu items References > Find 
Duplicates. Retain the more complete version of the reference.

If there are inconsistencies in your EndNote library (e.g. some journal 
names are written in full in some places and in other places they are 
abbreviated) you can import a complete Journal Term List via Tools > Open 
Term Lists. This can save a lot of manual cleaning up.

Citing research in Microsoft Word documents
To insert a citation in a Word document, position your mouse cursor 
where you want the citation to go, click the EndNote tab, then click 
Insert Citation. This will bring up a box where you can search for the 
reference and insert it. Once the citation has appeared in your text, right 
mouse click the citation to bring up some options: you may want to edit 
the citation so that, say, particular details are excluded or added. Once 
you’ve added citations to your document in this way, they will appear in a 
reference list at the end of the document in the style you have specified.

The EndNote X8 tab in Word communicates with EndNote. Use this to 
choose styles.

Toggle field codes in Word to see the code sitting behind EndNote 
references.
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Don’t accidentally remove field codes by using ‘paste text only’.

Don’t make edits to formatted in-text citations or reference lists (in Word) 
as reformatting will remove them. Instead, copy the list without the final 
paragraph mark, then paste into a new document, to show references 
without field codes; or paste the text as unformatted text in a new 
document.

EndNote Web
You can set up an account (free of charge) and share with others: www.
myendnoteweb.com. 

Getting help
EndNote’s help file is extensive and searchable.

Want to try EndNote? Download a free 30-day-trial version: http://
endnote.com/downloads/30-day-trial. 

Karin Hosking AE ELS

May General 
Meeting

Entertaining Editing
The last night of Autumn was chilly, but those who stayed in front of 
the fire missed a very interesting CSE meeting. We heard from Allan 
Sko, who has the distinction of being the step-grandson of CSE’s 
Distinguished Editor and Honorary Life Member, Elizabeth Manning 
Murphy, but who is also a serious achiever in his own right. Allan spoke 
about his association with BMA, the monthly entertainment magazine, 
and his progress from writer to editor and ultimately to owner/publisher.

Allan always wanted to be a writer, and finding work with BMA was a 
dream. After a few years, the editor left for the coast, and Allan was asked 
to take over. He enjoyed the work so much that he took a half share in the 
business and, when his partner wanted out, bought that partner out and 
became sole proprietor.

Allan is an entertaining speaker, and his slide show was full of detailed 
information and sound advice. He likes the magazine to have personality 
and flair, but there are style guidelines which writers are expected to 
follow. Almost all work published is original, which creates significant 
work for the editor in ensuring that tone, SPG (spelling, punctuation 
and grammar!), style and detail are consistent. Nurturing and educating 
writers is a big part of the job. The idea is to be positive about arts 
practice and, while giving fair reviews, to encourage local practitioners to 
create and to introduce and welcome far-flung creative visitors to the ACT 
Region.

InDesign and Photoshop are the essential tools of office, and Allan talked 
us through a model layout.

A lively question session created additional discussion around issues such 
as online publications, keeping star ratings consistent across a varied 
group of writers, and finding new writers and areas of interest. After the 
talk, we scoffed the rest of Mary’s ginger cake and headed back to our 
warm hearths.

Eris Jane Harrison AE
CSE Vice-President

http://www.myendnoteweb.com
http://www.myendnoteweb.com
http://endnote.com/downloads/30-day-trial
http://endnote.com/downloads/30-day-trial
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The truth … 
anything or 
nothing but

A hypothetical: you’re very happy to be offered a well-paid job—nonfiction—
especially as the cupboard is pretty bare, but when you start to read the 
copy, you find that it’s far from nonfiction; in fact, it’s a pack of lies aiming to 
delude the reader into believing the opposite of the truth. What do you do? 
Do you apply your best editing skills to make the lies as slick as possible? 
Do you give the job your worst shot because you’re totally uncommitted to 
it, but you need the money? Do you return the job, telling the client, maybe 
in no uncertain terms, that you can’t condone the promulgation of blatant 
dishonesty? Do you consult your colleagues to see what they think? There 
may be other possible responses, including nervous collapse. 

The recent emergence of wide and intense discussion about post-truth, 
truthiness, alternative facts and fake news got me thinking about responses 
to such a scenario. My interest was further stimulated by reading in the 
Fairfax press, just before last Christmas, the obituary of one Seumas Phelan 
‘sub-editor extraordinaire who campaigned for rights of workers’. Of 
Seumas it was written there that, among other things:

In an era when the skills and importance of sub-editors have been 
sidelined, Phelan’s recent death reminds us that the subjunctive is not 
subjective. The reams of condolence emails and Facebook posts that 
followed his death were warily written—crafted and reread to ensure 
no grammatical or spelling errors—paying tribute to the perfection he 
sought to bring to print.

‘Those were the days’, many regular readers of the daily news would have 
been thinking. It’s new world now, in which subeditors have been much 
more than sidelined; they are on the critically endangered list and there are 
no moves to save the species. It’s hard to miss the all kinds of grammatical 
and vocabular horrors and howlers that are, as a result, now multiplying 
exponentially in printed newspapers and their online derivatives.  

‘Subbies’ were the linchpins of newspaper production. They did the bulk 
of the in-house work needed to get out the daily edition, from writing, 
rewriting, editing and proofreading text, and fashioning headlines, to 
verifying information and story details and making sure that reports were 
accurate and did not compromise legality. Now that they’re almost gone, 
who checks for truth? Has their demise contributed to the rise and rise of 
post-truth, simply by default? 

Given the rapid news cycle, journalists submitting their stories might now 
often be under so much pressure that they are neither inclined nor have 
the time to make such checks. Perhaps they avoid stories where such 
checks would be needed, resulting in a dumbing-down of the news. This 
leads inevitably to the question: Does anybody care what’s happening? 
That some agencies do as evidenced by the multiplication of in-house and 
standalone fact-checking units. One can take some heart from this, but it 
makes one think why the subbies were shafted in the first place.1

Where do publications editors in their various guises stand in all this? 
Many of us might see ourselves in a wider world of publishing as, to some 
degree or other, akin to the subbies. If indeed we are such—and have a 
future—are we committed defenders of the truth? Should we be? Section 
A4 of the Australian Standards for Editing Practice deals with legal and 
ethical matters, but makes no mention of ‘truth’ or its analogues. Does this 
need attention, particularly in the current climate? Should our national body 
consider augmenting the standards to cover the issues raised here, or even 
perhaps develop a separate code of ethics or conduct for its members? 
Returning to our hypothetical and defining ethics as the basis for choosing 
between conflicting responsibilities, the drafting and promulgation of such 
a code might inform and provide reassurance to editors and their clients.

Ed Highley
Honorary Life Member

1. At the beginning of April, Fairfax 
Media announced [yet another] 
restructure, this one aiming to save 
its editorial budget $30m next year. 
According to one commentator, this 
would entail a 25 per cent reduction in 
the number of metropolitan editorial 
staff. The editorial director of the 
company said that an outcome of the 
reduction would be a cut in stories 
from 9,000 to 6,000 per month. 

http://www.smh.com.au/comment/obituaries/seumas-phelan-subeditor-extraordinaire-who-campaigned-for-rights-of-workers-20161222-gtgdgu.html
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Macquarie Dictionary, Seventh Edition

2017, Macquarie Dictionary Publishers, an imprint of Pan 
Macmillan Australia Pty Ltd 
Printed: 1792 pages (ISBN: 9781742619811)
Macquarie online: $120 
Booktopia: $83.25 (around when this newsletter published)

Review by Ed Highley, CSE’s Honorary Life Member

Hail to the new Macquarie 
The new edition of the Macquarie Dictionary—the seventh—published 
on the last day of February this year—is a thing of beauty twice over: it 
comes in two volumes, A–K and L–Z. When not being interrogated, the 
two return to intimacy in a robust but elegant slipcase. 

The Macquarie Dictionary is promoted and subtitled as ‘Australia’s 
National Dictionary’. Who could dispute this, given its more than forty-year 
publication record? I’m nevertheless curious as to why, between the sixth 
and seventh editions, the title and subtitle have been transposed. 

The new edition, sans slipcase, weighs in at just under four kilograms, 
about the same as the previous edition. Now, however, with two volumes, 
it becomes less of a weightlifting exercise to consult the good book. 
Some young and athletic authors, and editors keen to stay fit, may see 
this as a step backwards—there are always losers. The slipcase blurb 
reports that thousands of new words and senses have been added to the 
seventh. The seventh edition is at 1,792 pages, around 34 pages more 
than the sixth edition. 

As for previous editions, the design is excellent. These volumes are 
all-round functional and pleasing to the eye. It’s easy to find what 
you’re looking for and, when you get there, access to the information is 
untrammelled. Typesetting was done in India; the printing in China. Well, 
they might have made the glasses, but the wine is ours. 

The blurb reports that the seventh edition features, as well as the host of 
new words and senses already mentioned:

• a comprehensive record of English as it is used in Australia [I guess 
that is just what a national dictionary is meant to do]

• illustrative phrases, many from Australian literature, which show how a 
word is used in context   

• words and phrases from regional Australia [is that another country?]

• extensive usage notes

• etymologies of words and phrases.

There is a foreword—after the contents, I regret—by nationally treasured 
author Kate Grenville who applauds ‘The change in the publishing world 
that brought about the wealth of Australian writing that we now enjoy 
also produced the Macquarie Dictionary … The dictionary gave a validity 
to Australian English that meant that it could no longer be swept aside by 
foreign editors'. Too bloody right, mate! 

The Macquarie Word of the Year 2015 ‘captain’s call’ is among the new 
entries in the seventh edition, as are the honourable mentions for that 
year, ‘lumbersexual’ and ‘deso’, and the people’s choice runners-up, 
‘keyboard warrior’ and ‘wombat gate’. I initially imagined that ‘wombat 
gate’ might refer to a scandal surrounding the failure of a politician to 
declare the gift of one of these portly marsupials, possibly hairy-nosed, on 
their register of pecuniary interests. It turns out that it’s just a type of farm 
gate with a bit of a gully under it to let the lumbering beasties in and out 
during their nocturnal perambulations. Boring.  

Book review
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Production of the new edition was no doubt too far advanced for ‘fake 
news’, the 2016 winner, to make print. Perhaps by the eighth edition that 
scourge of the truth will be a thing of the past. One can but hope.

Some entries from earlier editions have disappeared—for example, that 
for Clarke Gable, star of, among other films, the classic Gone with the 
Wind. Interesting decision. Even-handedness applies, however: Vivien 
Leigh has also been blown away.  

Two of my pet hates are the serial murder and unconscionable dilution 
of the meanings of the words ‘enormity’ and ‘dilemma’. I was delighted 
to see that their true primary definitions have been retained by the 
seventh-edition editorial team. Hyperbolic journos and pollies take note: 
the enormity of your sins has not gone unnoticed—stick to just the big 
problems guys.

The new edition will cost you between $83.25 and $120, depending on 
where you shop. With your purchase, you will also receive a one-year 
subscription to the Macquarie Dictionary and Thesaurus online. Awesome!

Book review But Can I Start a Sentence with “But”?: Advice from 
the Chicago Style Q&A … 

By Elisabeth Thomas (With thanks to UCP for the review 
copy.)
University of Chicago Press, 2016. 
ISBN: 9780226370644.
Review originally published in Editors NSW Blue Pencil November 2016.

In the last several years (in fact for the last 20 or so years, now that 
I come to check the publication dates), there has been a trend in 
publishing to go behind the pages of major or substantial ‘reference 
book’ tomes and explain their development, workings or content. While 
authors, including Simon Winchester, David Crystal and Ammon Shea, 
have explored aspects of the Oxford English Dictionary, local works 
have included Susan Butler’s The Aitch Factor, and earlier titles, on the 
Macquarie Dictionary, and Bill Ramson’s Lexical Images: the Story of the 
Australian National Dictionary. Other writers, such as Kate Burridge, Kel 
Richards, Bill Bryson and others, have written popular works on words 
and their origins more generally.

Internationally, across the same period, there has been a matching flurry 
of books for the general market on grammar and its workings. Regular 
short guides to the long manuals have been joined by works such as the 
successful Eats, Shoots & Leaves by Lynn Truss or Mark Treddinick’s The 
Little Green Grammar Book.

One only hopes that these publishing trends not only continue but also 
come to have some effect on the people actually reading these books 
then using and applying what they may learn.

In But Can I Start a Sentence with “But”? (I’ll call it But hereafter), we 
have something of a blend of such works. Like The Aitch Factor, it is a 
distillation of readers’ feedback to the editors of a reference work and the 
editors’ responses—but this time it is upon matters of working with style 
rather than (though not excluding) words themselves.

The Chicago Manual of Style (CMOS), published for more than 100 years 
by the University of Chicago Press, is up to its 16th edition (2010) in 
hardcopy while online, subscribers can access the 16th and 15th editions. 

CMOS started a ‘Q&A’ on their website in 1997, though before that time 
the editors did take telephone queries regarding style. Later, it was 
decided to compile a monthly column of the choice questions and the 

http://www.chicagomanualofstyle.org
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replies. This then proved to be very popular, so despite availability online, 
there were calls for a collection.

A short foreword by Carol Fisher Saller (editor of the CMOS online Q&A) 
outlines why and how the book came to be. 

The book is arranged in seven chapters with interesting, and apt, names 
like ‘It’s not so much an issue of correctness as of ickiness’ and ‘Aaargh! 
to argh! to aahhh!’. Each chapter is then split into more obvious sections 
on commas, numbers, formatting and so on. Dilemmas over the usage of 
proper nouns result in the most coverage at eight pages.

CMOS may be one of the major style guides for written communication 
on the planet, but the editors do not insist upon it as absolute. In fact, 
many answers pointedly emphasise the guide in style guide:

‘What good is a rule that says you can’t help the reader when it 
seems like a good idea?’ (on abbreviations),

and

‘You never have to do anything that isn’t helpful. If a style guide 
says you do—you need a better guide’ (on initialisms). 

The Q&A ‘column’ has been useful to both the enquirers for advice as 
well as CMOS itself. Comments received have prompted clarifications 
and heralded changes in style preferences in subsequent editions of 
CMOS.

The answers included in the book incorporate sensible, and at times 
funny, comments; and are likely to draw mutters of agreement from 
some, and stern disapproval from other—or even the same—readers.

To answer a serious style problem, you are perhaps more likely to refer to 
the CMOS (or your style manual of choice or necessity). 

But can be useful as for a quick reminder about a style quandary of the 
moment: once read, any of the well-chosen examples may spring to mind 
as a clue when a relevant issue crops up.

It is excellent to see a nine-and-a-half page index in this small book of only 
118 pages. If you are not just having a casual browse of But, and actually 
want to make a very quick check on a matter of style at hand, the index is 
a clear and well-constructed aid. 

Even indexing itself is not neglected (as it so often is). A few pages look 
at ‘back of book’ problems. The foreword even refers to the index of the 
online site as ‘a killer index’.

The University of Chicago Press editorial staff would be an interesting 
crowd to meet and chat with. They seek to give ‘guidance’ and do not 
condemn as wrong (well, only occasionally—and I expect you will agree 
with them).

Most answers do explain the stance the editors take, though often they 
refer back to the relevant section of the CMOS in full, so if your interest 
is particularly piqued on an issue, you will have to chase up a 1.5 kg 
hardcopy or access to the online version.

They will also readily comment when the problem is more a matter of bad 
writing that cannot be saved by punctuation or grammar.

The editorial staff will allow themselves the occasional gentle swipe at the 
questioner: 

“Q. …Me and a fellow copyeditor are at odds.

A. …(PS I am averting my eyes from ‘Me and a fellow 
copyeditor are at odds’—please tell me this is just your fun 
e-mail writing style, or if it isn’t, that you aren’t editing anything 
important to our national security.)”

I mainly use my hardcopy of CMOS 16 to seek another opinion on a sticky 
point or to figure out why an American edited work may have taken a 
particular position.
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But is certainly worth a read for interest and amusement, let alone 
brushing up on style matters, whether or not Chicago is your style.

Those raised across either ocean from CMOS’s home may take exception 
to, or even umbrage at, a few, several or many of the recommendations 
made within these pages. But do not let that stop you from taking this 
little tome on the train or onto the lounge with a beverage of choice … 
and enjoy agreeing … or agreeing to disagree.

And should any reader (still) be wondering what position CMOS takes on 
the titular question: yes, you can.

To read more:

http://www.chicagomanualofstyle.org/qanda/latest.html free to non-
subscribers

http://www.chicagomanualofstyle.org/qanda/topicList.html 36 topics

https://twitter.com/ChicagoManual

http://cmosshoptalk.com/ 

A warm message from 
the Professional Editors’ 
Guild, South Africa
The Canberra Society of 
Editors figures significantly in 
conversation among editors in 

South Africa. Meeting with you this evening in person is indeed a privilege 
and a pleasure—thank you, Elizabeth, for making this possible. I bring 
warm greetings from our national organisation, the Professional Editors’ 
Guild, affectionately known as PEG, and its Gauteng branch. 

In recent years, the association between our two countries has intensified 
with our multilingual, multicultural identities as experienced in many 
different ways in our editing. We have challenges to share and address. 
May we continue to share ideas and benefit from this valuable connection, 
especially now that we have digital media supporting us. 

Thank you … and in Afrikaans, one of our eleven official languages: baie 
dankie.

Joan Fairhurst
26 April 2017
joanfair@global.co.za

Joan attended our April General Meeting and delivered this message on 
behalf of PEG.

mailto:joanfair%40global.co.za?subject=
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Schedule for next newsletter

The next edition of The Canberra editor 
will appear in August 2017. The copy 
deadline for that issue is 15 August.

The editor welcomes contributions by 
email: newsletter@editorscanberra.org.

All articles must be in .doc format.

Advertise in The Canberra editor is distributed to 
over 140 members of the Canberra 
Society of Editors, and to state 
and territory editors societies, 
affiliated societies, and interested 
organisations.

The newsletter is available for viewing 
or downloading at  
www.editorscanberra.org.

Regular features include Society 
columns, news and updates; reports 
of events, speakers, professional 
development and mentoring; and 
interesting and relevant articles, book 
reviews, and more.

Costs* and specifications

$40 1 col. w 54 x h 273 mm
$60 1/2 page w 180 x h 140 mm
$120 1 page w 178 x h 273 mm

Artwork is to be supplied as jpg/png/
tiff. RGB, 72 ppi. 

Alternatively, you may forward your 
logo and text to the Assistant Editor, 
Gab Lhuede, who will provide a basic 
design for your ad and provide a pdf 
file for only one round of proofing.

*These costs are subject to review.

http://www.editorscanberra.org
mailto:newsletter%40editorscanberra.org?subject=
www.editorscanberra.org
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